MicroWorldsJR
Resource Book with
Extended Reference Guide
We'd like to thank the following people for their efforts, insights and inspiration: Elena, Alain, Sergei, Alexei, Susan, Anton, Michael, Slava, René, Kirill, Vitaliy, Marina, Anna, Nikolai, Patrick, Mario, Brian, Billo, Paula, Sharnee, and Seymour.
Table of Contents

Section I - Introduction ...........................................................................3

Section II – Projects .............................................................................6
  Project 1 – Introducing MicroWorlds JR. ....................................................7
  Project 2 – Pattern Game ......................................................................9
  Project 3 – The Tortoise and the Hare ..................................................11
  Project 4 - My Favorite Place ..............................................................17
  Project 5 – Guess My Rule II ..............................................................21
  Project 6 – Tiling ...............................................................................27
  Project 7 – Geometric Shapes ..............................................................31
  Project 8 – Square Pictures ...............................................................36
  Project 9 – Spirals and Other Interesting Drawings ..............................40
  Project 10 – A Map of My Street .........................................................44

Section III - Reference .........................................................................48
  The MicroWorlds JR Screen ...............................................................48
  The Top Toolbar ...............................................................................50
  The Left Toolbar ..............................................................................53
  Instruction Lines ...............................................................................82
  Inside Turtles ..................................................................................85
  Inside Buttons ...............................................................................91
  Making Your Own Procedures ..........................................................93
  Menus ............................................................................................98

Section IV - Handy Techniques .............................................................102

Section V - MicroWorlds JR Commands vs. Traditional MicroWorlds Text Commands ..............................................................................105
MicroWorlds JR is the latest addition to the MicroWorlds family and the only version specifically designed for pre-readers and beginning readers. It provides young children with tools to create simple interactive projects and explore mathematical ideas on the computer. It includes painting tools, stamp-able shapes, text, buttons, multiple pages, and techniques to create simple animation, and it makes it possible for children to explore numbers, movement, and onscreen interactions through the use of an iconic programming and control language.

The star of the MicroWorlds world is the turtle – an onscreen, controllable object that provides children with a link between their real, concrete world and the more abstract virtual world of the computer. In the MicroWorlds world, children are in control. They control the turtle with iconic commands that tell the turtle to move, pivot, pause, put its pen down or pick it up, change and stamp its shape, play music, and much more. There’s no end to the types of activities and projects you can create with the turtle. As children become more familiar with MicroWorlds JR, they begin to use logic and problem-solving skills - skills that they will use throughout their lives - to develop more elaborate projects.
Why Use MicroWorlds JR?

MicroWorlds JR lets young children use the computer as a creating and thinking tool. It provides them with opportunities to explore various mathematical ideas (How big is a turn? How large is a large number? What are the components of a square or a triangle?) and build interactive projects and stories. As they build, children encounter questions and obstacles intrinsic to the building process. With guidance, they begin to see that the best way to solve these challenges is to think like the turtle. In so doing, they are able to break the process down into manageable and logical steps. They may also discover that there is more than one way to solve a problem or complete a project. The children begin to develop a “MicroWorlds way” of viewing problems – developing meta-cognitive skills that will be valuable throughout their lives.

For example, a child could use the turtle to draw a square. In so doing, the child would not only need to think about the attributes of a square, but she would also have to consider in which order to invoke MicroWorlds JR’s iconic commands to help the turtle draw the square, receiving immediate feedback after each command. If the commands are not in logical order, the results will be immediately obvious and the child can try a different sequence of commands. The child could even stand up and “walk” the square, using her kinesthetic knowledge to help her gain mathematical understanding. After drawing a square, the child may try to create other regular shapes and in so doing find similarities and differences and begin to formulate some “rules” about geometry.

Ten different project ideas are described in this book, but these are just the beginning. The projects introduce many, but not all, of the MicroWorlds JR features. Look through the Reference section of this book to discover other ideas and techniques.
Contents:

- MicroWorlds JR CD that contains:
  - MW JR program
  - Sample projects and Activity Starters
- MicroWorlds JR Resource Book
  - Projects
  - Basic Reference

Getting Started

Once the software is installed, it’s a good idea for you to become familiar with the software’s features and capabilities before using it with your students. You can do this by either creating some of the projects described in the Projects section or by trying the various features described in the Reference section.

MicroWorlds JR Samples and Activity Starters

The sample projects included on the CD provide ideas for building your own projects as well as playable environments for children. The Activity Starters contain different sets of starting shapes. These Starters can be used to create themed activities. To use these Starters, have students click on the Open Project button after they boot MicroWorlds JR. and then open the specified Activity Starter. The Activity Starters are write-protected. Students should immediately save the Activity Starter using Save as... and a new name.
Section II – Projects

Organization

Each project description that follows contains these sections:

- Curricular links
- MicroWorlds skills
- Prerequisite skills
- Introductory activity
- Main activity

Each project introduces new MicroWorlds JR features and incorporates features introduced in previous projects. You need not complete all projects nor complete the projects in the order in which they’re presented, but before starting a project take note of the prerequisite skills. Introduce any necessary skills the students may have missed if a project was skipped.

When setting up each workstation, make sure that each student, when saving a project, will be saving to the directory in which you want the projects kept. If you want students to save to a different drive, make sure this has been pre-selected. To check, save a sample project to this directory before the students begin working.
Project 1 – Introducing MicroWorlds JR.

The goal of this activity is to introduce the MicroWorlds JR environment, the painting tools and the steps needed to save a project. In order to introduce the painting tools, you may find it helpful to use a projector connected to your computer.

MicroWorlds JR Skills

- The turtle and how to move and drag it
- Painting Center
- Undo tool
- Save a project

Prerequisite Skills

None

Introductory Activity

Introduce students to the turtle and show them how they can move the turtle with the mouse by clicking on the turtle and dragging it. If they click on the turtle’s nose only and drag the turtle in an arc, it turns.

If the Painting Center is not displayed, click on the Open Painting Center button. Many students may be familiar with painting tools from other programs, but, if not, take a few minutes to show the children some painting techniques. You may also want to show them how to scroll through the various color shades. Give them some time to try the different tools and show them how to clear their pages to start again.
Before starting, the main activity, show students how the Clean button works. Clicking the Clean button erases the whole picture. Tell students that if they do this by mistake or for any mistake using the painting tools, they should:

1) **Stop clicking immediately!** If they click a second time they may not be able to recover their picture.

2) Click the *Undo* tool button in the top toolbar.

**Main Activity**

After your students have experimented a bit, they are ready to create an illustration. Keep the ideas very simple. Here are some suggestions:

- Stars and a moon in the night sky
- A field and sky with a sun and clouds
- A house or building
- Hills
- Your face
- A simple illustration of some topic you recently discussed in class

Although the turtle is the main character for many MicroWorlds JR activities, in this project he is more of a decoration, although it can be an interesting challenge to the students to creatively incorporate the turtle into their projects (for example, the turtle could be standing in front of a house or be an earring on a face picture.)

**Save your project**

It’s very important to set aside some time at the end of the class to show students how to save their projects. Point out the Save Project button on the top toolbar. When a student clicks this button, a dialog box appears. Each student must type a name for his or her project and then click the Save button in the dialog box.
Project 2 – Pattern Game

The goal of this activity is to have students create their own simple patterns using turtle shapes. They can then ask their friends to play Guess My Rule.

Curriculum Links:

- Math
  - Algebra:
    - Understand patterns
    - Recognize, describe, and extend patterns

MicroWorlds JR Skills

- Turtle Commands Center - Learn how to use various Turtle Command buttons:
  - Set the turtle to this shape
  - Grow (set the turtle to a larger size)
  - Shrink (set the turtle to a smaller size)
  - Stamp

Prerequisite Skills

- Painting Center
- Save a project

Introductory Activity

Have students click on the Turtle Commands Center button in the Center Openers section of the left toolbar. Explain that all the buttons in this part of the screen tell the turtle to do something.

Explain and, if possible, demonstrate that clicking on any shape in the Shapes Center at the bottom left sets the turtle to that shape (the turtle is “wearing” the shape). Each shape button is actually a “set the turtle to this shape” command.
Next, point out the command buttons on the right panel. Click on the Grow command button and then the Shrink command button to show what they do. Let students adjust the size of the turtle until they are satisfied.

Next, show students that if they click on the Stamp command button, the turtle stamps a copy of its shape on the background. If you move the turtle to another position on the screen, the stamped shape remains. Although it looks as if there are two turtles on the screen, explain that the stamped shape is now part of the background just like any of the drawings made with the painting tools in the first activity. The stamped shape cannot move like the turtle.

**Main Activity**

Have students create a repeating pattern using stamped shapes. For example, they may stamp two small dogs and one large dog, two small dogs and one large dog, etc. Or they may stamp one house, two flowers, and a fish, one house, two flowers and a fish.

Have each student create two patterns. Remind them to try and make each pattern different from the other and that their patterns can be simple or, if they prefer, more complicated. Also, remind students that to see a pattern, it must be repeated at least one time.

You may need to remind students how to erase a shape if they make a mistake or change their minds. They should open the Painting Center and use the Eraser tool.

Once all the students have created their patterns, have them save their project. Then pair up the students and let each student invite his or her partner to play “Guess My Rule”. When everyone has finished, have the class discuss all the different types of patterns that can be generated. Why must you stamp the pattern at least two times before asking your partner to guess the rule? Is there a limit to how long a pattern can be before it repeats?
Project 3 – The Tortoise and the Hare

Use animation and multiple turtles to create a simulation that compares the speed of different animals, vehicles or characters.

Curriculum Links

- **Math**
  - Measurement:
    - Make comparisons of measurements
    - Describe qualitative changes and differences to analyze change
- **Science**
  - Scientific Processes:
    - Create and explore a simple simulation of motion

MicroWorlds JR Skills

- **Turtle Center Commands including:**
  - Step (forward or back)
  - Wait
  - Stop
  - Click On the Turtle
  - Click Off the Turtle
- **Create multiple turtles**
- **Turtle backpack**
  - OnClick instructions
- **Animation**

Prerequisite Skills

- **Turtle Center Commands**
  - Set the Turtle to This Shape
  - Save a project
**Introductory Activity**

The turtle can do more than just wear shapes for stamping. It can also move using turtle commands. When the turtle moves a little and does this many times, Presto! You have animation.

Have one or two students walk across the room and ask the other students to describe what they are doing. They may say they take steps, they just go, etc. Show them they are taking steps, over and over again. Each step is not huge (they cannot cross the room in one step!), so step size is also something to consider. You may want to have one student take giant steps and the other take small steps to see the difference. The one who takes giant steps moves across the room faster.

When a turtle moves in an animation, it does the same thing – it takes one step, over and over and over again.

To show students how to create animation, start by introducing the Step command. Then show students how to create an instruction that starts when you click on the turtle.

**The Step command**

On the computer, have students set the turtle to the turtle shape, if it isn’t set to it already: To do this, open the Turtle Commands Center. Then either:

- Click on the *Set to the turtle shape* button in the Shapes Center, or
- Click on the *Set to the turtle shape* button in the Turtle Commands Center.

Next, show how the turtle moves. Click on the *Step* command button in the Turtle Commands Center. A dialog box opens. Set the distance the turtle will move each step. The distance can be set by either dragging the shoe or by typing a number in the box. First, try a big number, like 100. (Note: if the turtle is under the dialog box, move the box so the turtle is visible.)

Click **OK**.
The turtle moves. Next try a small number in the box. If the number is very small, it may be difficult to see the turtle move. Try a few times, so that everyone understands that the number in the box is the distance (in screen “dots” or pixels) the turtle moves in each step.

**OnClick**

Once students understand how to make the turtle move one step, it’s time to show them how to make it take step after step after step.

First, have students click on the turtle’s nose and drag it until it is pointing to the right. This will give students more room for their animation.

Ask students to “right-click” on the turtle (click on the turtle with the right mouse button). The turtle’s backpack opens. The backpack is where the turtle keeps its special instructions. In it, you can create several different types of actions.

The first type of action, in the tab on the top left, is an OnClick action. An Onclick action is one that runs when you click on the turtle once and that (if it’s an action that runs repeatedly) stops when you click on the turtle a second time. This is the only action students need to use at this time.

(Note: The other actions are:

- An OnColor action - runs when the turtle moves across a specific color.
- An OnTouching action - runs when the turtle touches another turtle.
- An OnSignal action - runs when the Signal command broadcasts a specific color.

The OnClick instruction line is, by default, the instruction line displayed when the turtle backpack first opens. If students start to click around, ask them to click on the tab on the left showing the hand holding the mouse.)
To create an OnClick action, you need to add commands to the instruction line. To do this:

1) Click on the Step command button in the Turtle Commands Center:

2) Set the number in the box. It should be a small number (five or less).

3) Click OK. The command appears in the turtle’s backpack.

4) Click the round arrow on the bottom of the turtle backpack. This means repeat the instruction over and over again – forever (or at least until you click on the turtle again). The backpack should look like this:

![Turtle Backpack Image]

5) Click OK.

Click on the turtle, and it should start whizzing across the screen. If it is going too fast, click on one of the Stop Everything buttons. (Note: There’s a Stop Everything button in the Turtle Commands Center and another one in the top toolbar. They are identical.)

Discuss how to make the turtle move more slowly. Making the step size smaller is one solution. Open the turtle’s backpack. Use the Key tool to change the step size without rewriting the instruction. Click the Key tool button in the General Tools section of the left toolbar and then click on the Step icon in the instruction list. The dialog box for Step opens and the number can be edited. Change the step size to 1 and try the animation again.

You can also use the Click on the turtle command in the Turtle Commands Center to start the OnClick instruction and the Click off the turtle command to stop it.
Wait command

Still too fast? Another way to slow the turtle is to have the turtle wait a little after each step: step-wait-step-wait.

Right-click on the turtle again and place the cursor after the Step command. Click on the Wait command button in the Turtle Commands Center. The Wait command gets MicroWorlds JR to wait a short time (a tick is one tenth of a second). The little bird shows the effect of various pause lengths…if the duration of the pause is very short (set to 1), the bird still moves fairly fast. If the pause is longer, the bird moves much more slowly.

Remember, to slow the animation, the pause does not have to be very long. Select a duration, click OK, and the Wait command is added to the instruction line in the turtle backpack.

Click OK. Test your animation.

Main Activity

Have students create a second turtle on their page. They should:

1) Click on the New Turtle button in the Object Creation section of the left toolbar.

2) Click on the page.

Next, have them turn the turtle by clicking on its nose and dragging it until it points in the same direction as the other turtle.

Set the turtle to a different shape, for example, the rabbit. The shape should be one that is “facing” in the same direction as the turtle. To set the turtle to a different shape, open the Turtle Commands Center and click on the shape in the Shapes Center.
Create an OnClick instruction for the second turtle. Is a rabbit faster or slower than a turtle? How do you create different speeds?

Two turtles can be set to move at different speeds by using different numbers for either the input to Step or for the input to Wait. Have students experiment. For example, the rabbit may have a step size of 10 and a wait duration of 1 while the turtle may have a step size of one and a wait duration of 10!

![Turtle](image1.png) ![Rabbit](image2.png)

Sometimes students forget to turn the turtle before setting it to a different shape. When they create an OnClick instruction, the turtle moves in the wrong direction. This is a great problem-solving opportunity. Ask the student what happened, what she wants the turtle to do and how she can correct the problem. Remember, to see in which direction the turtle is heading, set the turtle back to the original turtle shape.

Have students create other simulations by adding more turtles set to different shapes, for example, boats and dogs, or cars and airplanes, etc. They can then create OnClick instructions to have each turtle-object move at an appropriate relative speed (airplanes are fast, cars slow). Ask students to explain why they made their choices and how they decided on the instructions for each turtle.
Project 4 - My Favorite Place

Students have already learned how to use the painting tools, how to stamp a shape, and how to create a simple animation. They now combine these skills, moving from one center to the other, in order to create a picture of their favorite place. Once their pictures are complete, they use the Text center to add titles or short descriptive sentences.

Curriculum Links

- Language Arts
  - Creative writing:
    - Students write in a variety of forms
    - Students use various media to convey a message

MicroWorlds JR Skills

- Text
  - New text box
  - Add text
  - Format text

Prerequisite Skills

- Painting Center
- Turtle Command Center
  - Step
  - Pause
  - Set shape
- Stamp
- OnClick
- Save a project
Introductory Activity

Before students begin, discuss the theme – My Favorite Place – and have them think for a few minutes about what that is and how they can illustrate it. Make sure they understand how to move from center to center and what tools or commands are available in each center.

In the previous project, students created animated turtles. You may want to review the steps for setting a turtle to a different shape and getting it to move with an OnClick instruction.

Adding Text

Before starting, show students how to add text to their page. They should:

1) Click on the Text Center button in the Center Openers section of the left toolbar,
2) Click on the page in order to have a text box appear,
3) Click in the text box to type.

Once students click in the text box, the Text Center opens at the bottom of the screen. It contains clickable letters arranged in alphabetical order. Students can type using these clickable letters or the keyboard to add text. To create a capital letter using the clickable letters, hold down the Shift key and click on the letter.

Have each student write a title for the project or his or her name.

Demonstrate how to change text size, font, style or text color:

1) Highlight the text to be changed by holding the mouse button down and dragging across all the letters in the text.
2) Click on the appropriate function button in the Text Center.

Once students have completed their text, clicking anywhere outside the text box makes the text box transparent. If the students want to move their title, they can simply click on the text and drag it.
Often students change the text size, causing a scroll bar to appear in the text box.
Once they click outside of the box, the text box becomes transparent and not all of
their text is visible. If this is the case and not all the title is showing, students should:

1) Click on the text so that the text box reappears,
2) Drag one of the squares in the corners of the text box in order to enlarge the box
3) When the scroll bar disappears and all the text is visible, click outside the text
   box to make it transparent once again.

**Main Activity**

Have each of your students create a picture of his or her favorite place. In general,
it’s easier to start by painting a background picture with the painting tools and
then adding stamped shapes. Next, they can add one (or more) animated turtles.

![The Park](image)

Sometimes when students are using multiple animated turtles in a scene, they
want one turtle to be in back of or in front of another. The last turtle created is
always in front of the other turtles. Here is a technique to change the order of the
turtles. It makes use of the Edit menu, so you may choose to help pre-reading
students with this.
If the wrong turtle is in front:
1) Drag around the turtle that they want “in front” so that “handles” appear
2) Select Cut in the Edit menu
3) Select Paste in the Edit menu.

The pasted turtle is now in front of the other turtles.

**Challenges**

You probably noticed that there are multiple versions of some shapes, for example, the dog. If the turtle switches between these shapes as it moves, the dog looks as if it’s running. In this type of animation, the dog changes shape each time it steps, alternating between the different shapes.

To create this type of animation, right-click on the turtle to open its backpack. Then create an OnClick instruction by following these directions:

1) Click on the **first** dog shape to add a *Set the turtle to this shape* command to the instruction line
2) Click on the *Step* command button and set the size of the step (make it small)
3) Click on the *Wait* command button and set the duration of the pause.
4) Click on the **second** dog shape to add a *Set the turtle to this shape* command to the instruction line
5) Repeat step 2 and 3 above.

Set the OnClick instruction to *Forever* by clicking on the round arrow.

The turtle’s backpack should look like this:

6) Click **OK**.
Project 5 – Guess My Rule II

In this project, students program the turtle to follow a rule when it crosses a specific color. They can then ask their friends to guess the rule.

Curriculum Links

- Math
  - Algebra:
    - Recognize and understand patterns

MicroWorlds Skills

- OnColor instructions
- Turtle Commands
  - Turn
  - Set color
  - Set color randomly
- Music Center
  - Melody Editor
- Recording Center
  - Recording a sound

Prerequisite Skills

- Painting Center
- Turtle backpack
- OnClick
- Turtle Commands
  - Grow
  - Shrink
  - Step
  - Wait
- Save a project
Introductory Activity

Before starting the project, review some of the commands the students already know – Grow, Shrink, Step, and Wait. Introduce a few new commands that will be very useful in this project.

*Turn command*

You can change the heading of the turtle by using the *Turn* command. Click on the *Turn* command button in the Turtle Commands Center. The *Turn* dialog box opens containing a wheel. Drag the red knob – the numbers in the center change, showing the number of degrees the turtle is turning. Turn the wheel so that the red knob is pointing to the right. Click *OK* and you’ll see that the turtle is now heading to the right, also. Experiment with turning the turtle several times. The turtle can turn left or right.

*Set the turtle to a color command*

Click on the *Set color* command button. A scrollable palette of the colors in the Painting Center appears. Select one of the colors and click *OK*. The turtle (and its pen) changes to that color.

*Moving Backwards*

Turtles move forwards if the shoe in the *Step* dialog box is placed to the right of the 0. If it’s placed to the left of the 0, the turtle moves backwards.

*OnColor*

Using OnColor actions, students can program an action (a list of instructions) to occur when the turtle crosses a specific, pre-selected color.
First, have the children create a filled rectangle on the page using the painting tools. The rectangle can be any color. Then, they should click on the Pointer button in the General Tools section of the left toolbar to reset the cursor to the regular pointer shape.

Next, have students open the turtle’s backpack and click on the second tab from the left – the OnColor tab.

They should see two lines of little houses, each set to one of the main colors in the Painting Center. Have each child click on the house that’s the same color as the rectangle they drew. If they cannot remember which color they used (for example, they used a very light or dark shade), they can click on the rectangle on the page (the cursor automatically changes to the color picker). The house of the correct color is selected.

Next, have each child click on the Grow command button in the Turtle Commands Center. This inserts the Grow command into the OnColor instruction line. Do not click OK yet.

Finally, have students click on the OnClick tab in the turtle’s backpack. They should add instructions to have the turtle step and then wait a little over and over again, just as they did in earlier projects. Click OK to save all the instructions in the backpack and close it.

Have students turn the turtle so that when it moves, it crosses the rectangle. They should then click on the turtle. When the turtle touches the rectangle, it should grow.

Note that a turtle runs the same set of instructions for all shades of a color.

A turtle can have a different set of instructions for each of the different color houses that appear in the OnColor tab. That means a turtle can have up to 16 different OnColor instructions.
Main Activity

Have students use different colors to create a *Guess My Rule* game for their friends. Here are some suggestions for rules:

When I cross the color _______________

... I get bigger.
... I get smaller.
... I go backwards.
... I take a giant step.
... I turn.
... I change to another color.

Notes:

- Do not put the pen down as one of the rules because when the turtle draws a line it “sees” only the pen color, not the rest of the background colors.
- Do not use stamp as one of the rules. It will stamp over the background color and, again, the turtle won’t “see” the background.
- If the turtle has an “I get bigger rule” (using the *Grow* command) for one color, it’s a good idea that another color should have an “I get smaller” rule (using the *Shrink* command). Otherwise, the turtle grows and grows until it can’t grow anymore and then the rule stops working. The same is true if the turtle has an “I change to another color” rule for one color. You should have an “I change to my original color” rule, also.
Challenges

Here are some other rules students may want to try:

When I cross the color ________________...
   ... I change color randomly.
   ... I play music.

Setting the Turtle to Different Colors Randomly

Create an OnColor instruction to have the turtle change colors randomly (“I change color randomly.”) when it crosses a background color.

1) Open the turtle backpack and click on the OnColor tab. Select a color that doesn’t already have an instruction, for example, yellow.

2) Click on the Set color command in the Turtle Commands Center. The Set color dialog box opens.

3) In the dialog box, click on the dice in the lower left corner to select the random color picker.

4) Click OK.

Have the turtle move across the background color – in this example, yellow. The turtle should change to a different color each time it crosses yellow (or whatever color you used).
Melody Editor

Some students may want the turtle to play a note or sound when it crosses the color. Here’s how to create a melody:

Click on the Open Melody Center button in the Center Openers section of the left toolbar. In the Melody Center, click on the Create a melody button. The Melody Editor appears. Have students try some of the notes, instruments, different durations, etc. Once they click OK after creating a melody, the melody is saved in the Melody Center. Clicking on the melody’s button plays the melody. The Play this melody command can be used just like any of the turtle commands.

Students can get a readymade melody by clicking on the Choose a melody button in the Melody Center. This opens a dialog box that contains a list of melodies. Once a melody is selected, it is added to the Melody Center of the current project.

Students can also import pre-recorded sounds or create their own recording by clicking on the Open Recording Center button in the Open Centers section of the left toolbar. Clicking on the Create a Recording button opens the New Recording dialog box. Clicking on the Choose a recording button opens a dialog box that displays a list of pre-recorded sounds. Once a recording is selected, it is added to the Recording Center of the current project.
Project 6 – Tiling

Have students create their own tiles shapes for the turtle and then create pictures from the tiles.

Curriculum Links

- Math
  - Geometry:
    - Apply transformations to analyze mathematical situations.
    - Investigate and predict the results of putting together and taking apart two-dimensional shapes.

MicroWorlds Skills

- Turtle Commands Center
  - Create/edit shapes

Prerequisite Skills

- Create a turtle
- Painting Center
- Turtle Commands Center
  - Stamp
- Save a project
Introductory Activity

Students can create their own shapes for the turtle. These shapes can be used just like any other shape.

Have students open the Turtle Commands Center. They should then right-click on one of the empty shape spaces in the Shapes Center. The Shape Editor opens. It contains tools identical to those in the Painting Center.

To start, have students use the straight-line tool to draw a line in any color diagonally from the upper left corner to the lower right corner of the empty shape. They should then use the fill tool to fill one side of the square. Their shape should look like this:

![Shape Diagram]

Students can decorate the shape by adding some lines or dots of color, but only within the colored triangle.

Click OK to save the shape.

Next, make three copies of the shape. To do this, click on the Copy tool button to the left of the Shapes Center. Once this tool is selected, click on the newly-created shape (the hand turns into a fist as the shape is “grabbed”) and then click on an empty shape space in the Shapes Center. Repeat this process two more times so there are four identical shapes.
Four identical tiles are not very interesting. Right-click on one of the shapes to open the Shape Editor. Once open, click on the rotation tool in the editor to rotate the triangle 90 degrees (1/4 way around). Click OK. Do this to a second copy of the original shape, but, this time, rotate the shape twice (1/2 way around). Finally, right-click on the third copy of the shape and rotate it three times (3/4 of the way around). Each shape should have a different orientation.

Main Activity

Have students create pictures using their new set of tiles. With four triangles, they should be able to create squares and other geometric shapes to use in their pictures. Here are some ideas:

One of the simplest ways to set up the project is to create four turtles. Each turtle should be set to one of the tile shapes. A student can place the turtle where he or she wants it and then click on the Stamp command.
An alternate method is to create 12 - 16 turtles, so that three or four turtles are set to each shape. The student can then move them around to create the picture he or she wants and then stamp each shape. An easy way to do this is to create one set of four turtles, each with a different shape (a different orientation). Drag around all four turtles, then:

1) Select Copy in the Edit menu (or use Ctrl-C)
2) Select Paste in the Edit menu (or use Ctrl-V).

Paste a few times to get a few sets of tiles. The student should then move all the turtles to the side of the page. Once the picture is complete, students can remove the excess turtles with the Cut tool (the “scissors”) or by selecting them and clicking Delete.

**Some Important Tips**

- Sometimes the wrong turtle is stamped. Use the Eraser tool in the Painting Center to erase the stamped shape.

- To make sure the correct turtle gets stamped, click on the Who is listening? button in the top toolbar to see which turtle is the current (listening) turtle. If the wrong turtle is listening, click on the turtle you want to be listening. Dragging on the turtle will not make the dragged turtle the current turtle – you must click on it.
Project 7 – Geometric Shapes

You can use the turtle to draw geometric shapes. In so doing, students can use their knowledge of how they move to help them understand the properties of these shapes.

Curriculum Links

- Math
  - Geometry:
    - Recognize, draw and compare two-dimensional shapes.
    - Describe attributes of two-dimensional shapes.
    - Describe, interpret and apply ideas about direction and distance in navigating space.

- Science
  - Scientific Processes:
    - Generate a hypothesis, test it, and reflect on results.

MicroWorlds Skills

- Turtle Commands Center
  - Pen down

Prerequisite Skills

- Turtle Commands Center
  - Step
  - Right and left Turn
- Save a project
**Introductory Activity**

This exploration makes an excellent group activity. If possible, use a projector so that the whole class can participate. If this is not possible, work with small groups so that all the students can see the results of their math experiments.

**Turtle Commands - Pen Down**

Every turtle has a pen that it can use for drawing. When you open a new project in MicroWorlds JR, the turtle's pen is up. Open the Turtle Commands Center and click on the *Pen down* command button. Now the turtle's pen is down and it can draw with it.

To show students how turtles draw, click on the *Step* command button and set the step size to 50. Click *OK*. The turtle should have moved and left a trail.

![Turtle](image)

**All About Squares**

Ask your students to describe a square. They should be able to tell you that it has four sides and four corners (or turns). Through discussion, they should also come to realize that all the sides are the same size and all the corners are the same size. Have one or two students stand up and "walk a square." Point out that they should stop at the same place as where they started and they should be heading in the same direction. So, if when they started they were facing the front of the classroom, they should be facing the front of the classroom when they finish.

The line the turtle drew could be the first side of a square. Ask students what comes next. The turn, of course. Ask if they can guess how much the turtle should turn. Have them stand up and turn to show you.
Click on the *Turn* command button in the Turtle Commands Center. Show students that you can change the heading of the turtle by dragging the red knob. When you click *OK*, the turtle sets its heading to whatever direction the red knob was pointing. Experiment with turning the turtle several times.

Next, point the turtle straight up (either by dragging it or using the *Head north* command). Click on the *Turn* command button. The red knob should be pointing to the top and 0 should appear in the gray center window.

Explain to students that if the red knob is pointing up when the turtle starts drawing a square, *it should be pointing up when they complete their shape*. In drawing a square, the red knob should make a complete trip around the wheel.

Turn the wheel clockwise and show how far around that would be. Once 350 is displayed in the gray center window, use the right arrow key button at the top of the dialog box to increase the turn size one degree at a time. You should get to 359 before the number is reset to 0.

Note that the red knob can be moved either to the right (*Turn right*) or the left (*Turn left*). Use only one direction when creating your square.

**Drawing a Square**

Set the red knob so that it is pointing straight up (the number 0 should be showing in the gray window). Remind students that you have already drawn the first side of the square. Slowly turn the wheel clockwise. Ask the students to tell you to stop when the red knob is pointing in the direction the turtle should be heading after it turns the first corner of the square. They should tell you to stop when the number in the window equals 90. If not, keep going until the students tell you to stop. Click *OK*. The turtle should turn.

Continue drawing the square, no matter what number was chosen. Draw another side. Since this is a square, the length of the side (the step size in the *Step* command) should be the same number that was used to draw the first side.
The amount turned at each corner (the turn size in the Turn command) should also be the same for each corner since all the corners of a square are equal. Turn the turtle again using whatever number was used before. Remind students that on the fourth turn, the turtle (and the red knob) should end up pointing straight up.

Draw four sides and four corners. Did they create a square? Did the red knob end up pointing straight up? If not, keep track of the size of the turn and try again, testing another turn size. Keep trying until the students test a turn of 90. It’s important for students to realize that they can start with any size for the side, but they can only draw a square if the number for the turn is 90.

Having four turns of 90 means that when drawing a square the turtle turns, altogether, 360 (degrees). The turtle turns a total of 360 degrees, no matter what geometric shape you are drawing. This is called the Total Turtle Trip.

Now, use the same technique to draw a hexagon, a figure with six sides. Once again, the students can pick any number for the size of the side. Then have them try to figure out what number works for the size of the turn (60). Remind them that the turtle must turn six equal turns and, once complete, the turtle should be pointing straight up. Keep track of the different angles tested. For example, the students may guess that the turtle should turn 50 at each turn. After six turns, the turtle will not be pointing straight up. The figure will not even be closed. Ask the students if this means the number is too small (yes) or too big (no).
**Main Activity**

Organize the students into pairs. One student should be the Counter/Recorder and count the sides as they're drawn, keep track of the number of turns, and write down on a piece of paper, each turn size tested. The other student should control the turtle.

Ask each pair to find the size of the turn for some additional shapes, for example an octagon (45 for each turn), a nonagon (40 for each turn) or a triangle (120 for each turn). Students should take turns being the Counter/Recorder and the Turtle Controller. Remember: Use the arrow keys in the Turn dialog box to set the turn sizes to numbers not ending in 0.

**Challenge**

Ask students to try to draw a circle using the *Step* and *Turn* commands. How many sides does a circle have? In reality, you cannot draw a true circle using MicroWorlds JR. But students can see that the greater the number of sides, the closer they come to a circle shape.

Have students try the following: step size = 20 and turn size = 10. Suggestion: Instead of repeating this instruction 36 times, have students create an OnClick instruction using these *Step* and *Turn* commands and set it to Forever.
Project 8 – Square Pictures

By creating a square procedure, students can explore patterns and designs created using only squares. They can then write a story to go with their drawing.

Curriculum Links

• Math
  ° Geometry:
    - Recognize geometric shapes and structures in the environment
    - Understand attributes of two-dimensional shapes

• Language Arts
  ° Creative writing:
    - Students write in a variety of forms

MicroWorlds Skills

• Create a procedure

Prerequisite Skills

• Turtle Commands Center
  ° Step
  ° Turn
• Text Center
• Save a project
Introductory Activity

MicroWorlds JR comes with a set of built-in commands (*Step, Turn, Stamp*, etc.), but students can create new commands by defining their own procedures.

**Procedures**

A procedure is an organized set of commands that have been grouped together as a single user-defined command with its own label. It contains commands that will be used over and over again in the same order. You create a procedure so that you do not need to write the complete list of commands each time you want to use it. This user-defined command acts just like any of the built-in commands. The only difference is that it only works in the project in which it was created.

For example, instead of writing all the instructions to draw a square each time you want to draw one, create a *Square* procedure.

Have students open the Turtle Commands Center and right click on one of the empty command spaces (the spaces on the right, *not* one of those in the Shapes Center!).

Here are two ways to create a *Square* procedure:

1) Have students add all the instructions they used to draw a square.

Their procedure box should look like this:

(Note: The *Step* command may use a different number.)
Leave *Repeat* set to 1.

Have students create a label for their procedure by clicking the *Create a label* button. Then click *OK*.

A new command appears in the Turtle Commands Center.

OR....

2) Have students add one *Step* and one *Turn* command to draw the first side and first corner of a square. Set *Repeat* to 4.

Their Procedure box should look like this:

![Procedure](image)

(Note: The *Step* command may use a different number.)

Have students create a label for their procedure by clicking the *Create a label* button. Then click *OK*.

A new command appears in the Turtle Commands Center.

Tell students to put the turtle’s pen down and then click this new command. Have them play with the *Square* procedure a bit. For example, they could create spinning squares by drawing a square, turning the turtle a little, drawing another square, turning the same amount again, etc.
If students aren’t sure what is happening, right-click on the Square procedure button. The cursor should be at the beginning of the instruction line. Click the Step by step button to run each instruction one at a time. Make sure the procedure dialog box is not covering the turtle!

**Handy Technique - Duplicating a procedure**

To duplicate a Square procedure to create a Smallsquare procedure.

1) Click on the Copy tool to the left of the Turtle Commands Center and drag the copy to an empty command space.

2) Right-click on the new procedure to open its procedure box.

3) Click on the Key tool button in the General Tools section of the left toolbar. Then click on the Step command(s) to open the Step dialog box. Change the step size to a smaller number for each Step command.

4) Click on the Label Editor button to create a different label for this new procedure. Click OK.

**Main Activity**

Students should create a picture with squares. It could be a picture of spinning squares, a picture of robots, houses, whatever they can create with squares! They can fill their squares with color using the painting tools.

For example, students could draw a building using a large square, then use small squares to draw windows in the building. They can draw small squares by either duplicating the procedure and making a Smallsquare procedure or by reducing the step size for each Step command in their Square procedure. Remember, you can use the Key tool in the General Tools section of the left toolbar to change the step size without rewriting the list of instructions. Click the Key tool button in the General Tools section of the left toolbar and then click on the Step command in the instruction list. The dialog box for that instruction opens and input to Step can be changed.

Next, have students create a text box and write a few sentences to describe their picture. Finally, they can give their story and picture a title.
Project 9 – Spirals and Other Interesting Drawings

Students explore the nature of spirals as they learn how to create these beautiful geometric shapes.

Curriculum Links

- Math
  - Geometry:
    - Describe attributes and parts of two-dimensional shapes
    - Investigate the results of putting together and taking apart the parts of two-dimensional shapes
    - Relate ideas in geometry to ideas in number and measurement
  - Number:
    - Understand the effects of adding and subtracting whole numbers
    - Connect number words and numerals to the quantities they represent using various models

MicroWorlds JR Skills

- Create multiple pages

Prerequisite Skills

- Turtle Commands center
  - Step
  - Turn
  - Pen down
- Save a project
Introductory Activity

Show students the following pictures:

Ask if they know what these are. Not all students may know what a spiral is or that spirals are not always circular. Talk about the sides and turns (angles) of a spiral. How would students describe them? Are the turns always the same? Are the sides always the same? Have one or two of the students “walk a spiral” while the other students provide instructions.

Open MicroWorlds JR. Put the turtle’s pen down and ask students what command you should give the turtle to start drawing a spiral. You can start with either a Turn command or a Step command. For example, you may start with a Step command with the step size set to 5. After the turtle steps, it must turn. Select a turn size, for example 120.
Create a few additional sides and angles of the spiral. Each time, set the step size to its current size plus 5. Always leave the turn number the same. In this example, the commands would be:

Step 10  
Turn 120  
Step 15  
Turn 120  
Step 20  
Turn 120  
Step 25  
Turn 120  

....and so on. Gradually, students will see the spiral emerging.

As you create the spiral, write the step size and the turn size in a text box or ask the students to keep track of the amounts on a piece of paper.

What is the rule for turning? The number is always the same.

What is the rule for taking steps? The number is always the previous step size + 5.

Before students start creating their own spirals, show them how to add a new page to their project. By doing so, they can create one spiral on each page and won’t need to erase an old spiral to make room for a new one.

To add a page, students should open the Page Center by clicking on the Page Center button in the Center Openers toolbar. Click on the Create a page button on the left end of the Page Center and add a new page. There should now be two page buttons in the Page Center. Each button is a Get this page command. To return to page 1, students should click the Get page1 button. To go to page 2, students should click the Get page 2 button.
Students may want to create a unique label for each Get this page command. To do so, they can right-click on the page button or click on the button with the Key tool to open the Label Editor. Once they've completed their label, they can click OK to return to the MicroWorlds JR screen.

**Main Activity**

Have students work in pairs. Ask each group of students to create at least one spiral. They can use any number for Turn but they must use the same number for all the turns in the spiral. Students can start with any size step, but they must add the same amount to the step size each time they draw a side of the spiral. One student should be the Counter/Recorder and write down the step size for each step. The other student should command the turtle. Students can take turns at each job. Encourage students to use different colors as they build their spirals.

Once every group has created a spiral, have each of them show their spiral to the class and explain how they created it. The students should explain what their number rule was for the Step command.

**Challenge**

Sides of spirals can get smaller, too. Ask students what the number rule could be for a spiral that gets smaller. See if they can draw a spiral that gets smaller. Is it different from one that gets larger?
Project 10 – A Map of My Street

Students integrate many of the skills they’ve learned in previous projects to create a multi-page project that includes a map of their street and a description of where they live, with buttons to switch from page to page.

Curriculum Links

- Language Arts
  - Descriptive writing
  - Using different media to convey information
- Math
  - Geometry:
    - Find and name locations with simple relationships in coordinate systems such as maps
    - Describe and interpret direction and distance in navigating space

MicroWorlds Skills

- Create buttons
- Switch pages with buttons
- Stamp text
- Painting Center
  - Freeze background

Prerequisite Skills

- Painting Center
- Turtle Commands Center
  - Step
  - Turn
  - Pause
- Text Center
- Create multiple pages
- Save a project
Introductory Activity

At this point, students should be very familiar with many of the MicroWorlds JR tools. By using the painting tools they can draw a map of their street, label the different landmarks with text and even add some animated action to the map. On the second page of their project, students can describe the street and where their house is.

Have students create a second page in their project. Each page button appearing in the Pages Center is really a Get this page command. It’s possible to switch from page to page by opening the Page Center and clicking on the Get this page commands to change pages. Another way to change pages easily is to use user-created buttons.

While on page 2 of the project, click on the New Button tool in the Object Creation section of the left toolbar. A dialog box opens. Click on the Get page1 button in the Pages Center. The command is added to the new button’s instruction list. Click OK in the button dialog box. A button appears on the page and on the button is the label for the Get page1 command.

A user-created button shows exactly what command or commands will be executed when the button is pressed (buttons can contain more than one command). Click on the button and page 1 appears. Following the same steps, students should create a button on page 1 that opens page 2.

Students have now created a navigation system for their project. These buttons can be placed anywhere on their pages, but you probably do not want them in the center of the page where the map and the description will be.
Useful Techniques

Before starting the project, show students the following two useful techniques.

**Freeze Background**

The *Freeze background* button is in the Painting Center. Once frozen, a background cannot be erased. Any new drawings created after clicking on *Freeze background*, whether created with the painting tools, a turtle with its pen down, or by stamping a turtle or text, can be erased with the eraser, but the frozen background remains. It is a good idea to freeze the background before stamping text or any shapes that you think you may want to change!

**Stamp Text**

Stamping the text makes it part of the background. Stamped text does not move and cannot accidentally be changed. It can no longer be edited and can only be erased using the eraser. To stamp the text, click on the *Stamp text* button in the Painting Center. Then click on the text box that is to be stamped. This stamps an image of the text onto the background, making it part of the picture. The text box is still there, as a floating object. To remove it, click on the *Cut* tool (the “scissors”) in the General Tools section of the left toolbar and click on the text box.

**Presentation Mode**

Presentation mode is used for demonstrating completed projects. In presentation mode, the toolbars, menus, and centers are hidden, the project is centered on the screen and the surrounding area is filled. If your project has several pages, you must have a way to go from page to page, such as the navigation system you created with the buttons.

To get out of presentation mode, press the Esc key on the keyboard or click twice outside the project area.
Main Activity

Have each student draw a map of his or her street. They can stamp turtles wearing house or apartment shapes to show where they live or draw the buildings. They should label the street name and their houses using text boxes. It’s a good idea to stamp the text in order to make sure the text box is not accidentally moved. Remind students to freeze the background before stamping the text.

Students may want to add some animation, such as a car moving down the street, a dog running, or a person walking.

Next, on page 2, students can explain how someone could figure out which house is theirs. For example, they could write “I live on the corner.” Or “My house is the one with the yellow windows,” or “My house is the third house from the corner.”

Students can set their projects to Presentation Mode and present them to their classmates.
Section III - Reference

This section contains what you need to know to use the software and to complete all the projects in this book. It explains all the various icons and some useful techniques.

The MicroWorlds JR Screen

Clicking on one of the Center Openers changes the contents of the Work Centers area, in the lower part of the screen.
In addition to the Painting Center illustrated above, clicking on opens the Turtle Commands Center. It contains the Shapes Center on the left and turtle commands on the right:

Clicking on opens the Page Center. Here is where you create additional pages for your project. Each page button is a command that opens that page. Page labels can be edited to make them more meaningful:

Clicking on opens the Recording Center. Use it to create your own recordings or add pre-recorded audio clips to your project. Each labeled button acts as a command to play the audio clip. Button labels can be edited to make them more meaningful:

Clicking on opens the Melody Center. Use it to create your own melodies or to add pre-recorded melodies to your project. Each button that is created acts as a command to play the audio clip. Button labels can be edited to make them more meaningful:
Clicking on , then on the page, creates a text box. Clicking inside a text box opens the Text Center. In that sense, this tool works as an “Object Creator” and a “Centers Opener” at the same time. You can use the Text Center to type letters and numbers, format your text and access the spell checker:

![The Top Toolbar][1]

**The Top Toolbar**

The Top toolbar contains tools that are always present while working on your projects.

![The Top Toolbar](image)

### Pointer

Sets the cursor back to the regular pointer. Click on this tool to “get rid” of a tool you don’t want – for example if you pick the Text Stamper and you change your mind.

The normal pointer is used to:

- Click on “clickable” turtles and buttons;
- Select or move things around on your page;
- Click on different tools in the toolbars and centers;
- Re-enter a text box (click on a transparent text box and it becomes opaque again – click inside the text box to change its contents).
New Project

Opens a new project. A dialog box opens to ask if the current project should be saved or not.

Open Project

Opens a browser window so that you can select a project to open.

Save Project

Saves the current project to a specified location with whatever name you give it. If the project was previously saved, clicking this icon overwrites the earlier version. If you want to save this version as a new project, select Save as in the File menu.

Print Project

Opens the printing dialog box. Select the parameters that you want and click OK to print the page.

Presentation mode

Used for demonstrating completed projects. In Presentation Mode, the toolbars, menus, and centers are hidden, the project is centered on the screen and the surrounding area is filled. If your project has several pages, you must have a way to go from page to page. See the technique Switching Pages in the section Handy Techniques.

To get out of Presentation Mode, press the Esc key on the keyboard or click twice outside the project area.
Stop Everything

Stops all running processes. Processes can be an OnClick instruction for turtles (for example, an animation), the instructions of a button, a melody, a sound, etc.

Undo

Undoes the previous action. Can be used after a Cut (with scissors) operation or painting actions. The keyboard equivalent is Ctrl-Z.

Who (what turtle) is listening?

Indicates which turtle will follow the next turtle command. The “listening” turtle is also called the current turtle. This is very useful if there are multiple turtles on the screen. When you click on this tool, the current turtle flashes. If this is not the turtle that you wish to address, simply click on the turtle of your choice to make it the current turtle.

Signal Viewer

This area is a viewer rather than a tool. When the Signal Viewer flashes a bright color for a second, this indicates that a “color” signal is being broadcast. All other times, the Signal Viewer is dimmed and set to the color of the last color signal broadcast.

Light signals can be broadcast by way of different actions or events (by clicking the Signal command in the Turtle Commands Center, by clicking a turtle with a signal instruction, when a turtle steps on a certain color, etc.) and turtles can be programmed to “react” to light signals. The signals are a way of sending a message from one turtle to another. When programming light signals, looking at this viewer can help students understand what is happening.

See Signal in the section Turtle Commands and OnSignal in the section Inside Turtles.
The Left Toolbar

There are three types of tools in the left toolbar: the General tools, the Object Creation tools and the Center Openers. The New text box tool belongs to two categories as it is used to create text boxes and open the Text Center.

General Tools

Key Tool

The Key tool “opens” objects so that their contents can be edited. Click on this tool and then on

- A text box to edit the text;
- A turtle or a button to edit its instructions. If the Key tool doesn’t seem to work, you may be clicking on stamped text instead of a real text box or on a stamped turtle instead of a real turtle.

The key can also be used to edit any command that requires a number as input in a procedure, button, or turtle backpack instruction line. Click the Key tool button and then click on any icon in the instruction list that uses a number as input. The dialog box for that command opens and the number can be edited. See the sections Inside Buttons, Inside Turtles and Making Your Own Procedures further down.
Cut (Scissors)

Changes the cursor to scissors. The scissors are used for cutting objects, such as turtles, text boxes and buttons present on a page, or pages in the Page Center, melodies in the Melody Center or sounds in the Recording Center. If an object is cut by mistake, immediately click on the Undo button on the top toolbar to undo the cut.

Object Creation

New Turtle

Click on this tool and then on the page and a new turtle is added to the page. A new page always has one turtle on its page when it is created.

If you need a lot of turtles “that won’t move”, like several trees to make a forest, it may be better to use only one turtle and stamp it several times. Stamped turtles become part of the background and won’t be “moved” by accident. See Stamp in the section Turtle Commands Center.

There is a lot to say about the turtles and their backpacks. See the section Inside Turtles later in this Guide.
New Button

Click on this button and then on the page to add a user-created button.
The following dialog box appears:

To add instructions inside the button, simply open the Center that contains the
type of command you want to add, then click on the desired commands. A button
can carry:

- Turtle commands to act on turtles;
- Page commands to go to a different page;
- Recording commands to play sounds;
- Melody commands to play melodies.

Buttons cannot act on text or text boxes, and they cannot contain any of the
functions found in the Painting Center (use turtle commands to draw instead).

There is a lot to say about buttons, See the section Inside Buttons later in this Guide.
New Text Box

Click on this button and then click on the page to create a text box. The text box appears with its “handles”:

You can resize the text box immediately (drag one of its handles)...

...or relocate it (drag it from anywhere inside the box).

...or, you can simply click inside the text box and start typing. Clicking inside the text box gives you a cursor and opens the Text Center:
You can click the alphabetically arranged letters in the Text Center or use the keyboard to insert characters into the text box.

Using the formatting tools in the Text Center, you can change the text font, size, color or style. To do this, select some or all the text in your text box. Then choose one or more of the options in the Text Center: If no text is selected, any changes appear only in text added after the cursor insertion point.

**Spell Checker**

Once you have typed the text in a text box, you can check the spelling of the text in the current text box if you have Microsoft Word installed on your computer. The spell checker takes the same settings as those already in Microsoft Word. If a word is found that the spell checker cannot identify, the following dialog opens:

If some text is selected, the spell checking is done only on the selected text.
Center Openers

The Center Openers open the many “Work Centers” in the area below the page. Note that entering a text box also opens a Work Center, but this tool is described in the previous section, as it is also an object creator.

Turtle Shapes and Turtle Commands Center

Clicking on in the Center Openers toolbar opens the Turtle Commands Center. The section on the left is the Shapes Center. It contains shape command buttons to set the turtle to one of the predefined shapes plus empty shape spaces where you can create your own shapes. The section on the right contains turtle commands and empty command spaces where you can create procedures.
You can use the shape commands and the turtle commands in direct mode: click on any of them to act on the current turtle.

The current turtle is the last turtle that you have created or clicked on. To see which turtle is the current turtle, click on the Who is listening? tool so that the current turtle flashes in yellow. If this not the turtle you want to be listening, click on the right turtle and again click on the Who is listening? button.

You can also use these commands to construct instruction lines inside turtles, buttons or procedures. For more information about using these commands in instruction lines, see Inside Turtles, Inside Buttons and Making Your Own Procedures, further down in this Guide.

Shape commands

Clicking on any of these shapes instructs MicroWorlds JR to give whatever shape appears in the square to the current turtle. Nothing happens when you click on empty shape spaces.

Clicking on the turtle on the left sets the turtle on the screen to the original turtle shape. The turtle shape is the only shape that rotates as a turtle turns, indicating in which direction it is heading. All other shapes are like costumes and they always appear as they are in the Shapes Center, no matter in which direction the turtle is heading. To see in which direction the turtle is heading, set the turtle to the original turtle shape or click on the Turn command button.

You can modify the existing shapes, duplicate existing shapes, or create your own shapes.
Modifying existing shapes and creating your own shapes

Right-click on any shape, empty or not, to open the Shape Editor:

Drag the black square in this area to display different sections of the shape. This black square only appears if the shape is larger than 40 pixels by 40 pixels.

Use the painting tools to modify the shape. Note that you can paste in graphics that you copied from outside of the Shape Editor or even from a different application.

Click on to enlarge or shrink the “working area” for drawing the shape (this doesn’t change the size of the turtle, only the “drawing area”).

Click on to rotate the shape 90 degrees clockwise.

Click on to flip the shape horizontally. This is useful when you need a shape facing the other direction.

Click on OK to save your changes, or on Cancel to close the editor without saving the changes you made.
Duplicating Existing Shapes

Before modifying a shape, or when you need a shape (such as an animal) pointing in both directions, you may want to duplicate a shape before editing it. To duplicate a shape:

1) Click on this Copy tool to the left of the Shape Center.
2) Click on the shape that you wish to duplicate. The hand closes, indicating that it has “grabbed” the image.
3) Click on an empty shape space. You now have two identical shapes. Right-click on one of them to edit it.

To create a project using your own shapes, refer to the section, Handy Techniques at the end of the book.

Turtle commands

Each of the icons in this scrolling area represents a built-in command for the turtle. See below for a description of each of these commands.

The blank spaces can be used to create sets of commands grouped together by the user. These groups of commands are called procedures. A procedure is a user-created command. It behaves just like built-in commands, except it is only available in the project in which it is created. Refer to Making your Own Procedures, below.

Every turtle command icon has a corresponding text command in the MicroWorlds language. Using the names of the iconic commands helps give children a language in which to discuss their actions – a language that’s consistent and understood by others. Refer to the section MicroWorlds JR Commands vs Traditional MicroWorlds Text Commands.
Some commands require additional information – input. Clicking on those commands opens a command dialog box in which you can set the input value.

The commands in the top two rows in the Turtle Commands Center are:

<table>
<thead>
<tr>
<th>Grow</th>
<th>Shrink</th>
<th>Stamp</th>
<th>Clean page</th>
<th>Set to shape</th>
<th>Stop everything</th>
</tr>
</thead>
<tbody>
<tr>
<td>🍃</td>
<td>🍃</td>
<td>🍃</td>
<td>🍃</td>
<td>🍃</td>
<td>🍃</td>
</tr>
<tr>
<td>🍃</td>
<td>🍃</td>
<td>🍃</td>
<td>🍃</td>
<td>🍃</td>
<td>🍃</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Step</th>
<th>Turn</th>
<th>Wait</th>
<th>Pen down</th>
<th>Pen up</th>
<th>Set color &amp; pen size</th>
<th>Empty squares to place your own procedures</th>
</tr>
</thead>
<tbody>
<tr>
<td>🚶</td>
<td>🔄</td>
<td>🔄</td>
<td>🟥</td>
<td>🟥</td>
<td>🟥</td>
<td>🟥</td>
</tr>
<tr>
<td>🚶</td>
<td>🔄</td>
<td>🔄</td>
<td>🟥</td>
<td>🟥</td>
<td>🟥</td>
<td>🟥</td>
</tr>
</tbody>
</table>

The commands in the bottom two rows in the Turtle Commands Center are:

<table>
<thead>
<tr>
<th>Home</th>
<th>Head north</th>
<th>Hide</th>
<th>Show</th>
<th>Click off the turtle</th>
<th>Click on the turtle</th>
</tr>
</thead>
<tbody>
<tr>
<td>🏡</td>
<td>🏡</td>
<td>🏡</td>
<td>🏡</td>
<td>🏡</td>
<td>🏡</td>
</tr>
<tr>
<td>🏡</td>
<td>🏡</td>
<td>🏡</td>
<td>🏡</td>
<td>🏡</td>
<td>🏡</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Signal</th>
<th>Empty squares to place your own procedures</th>
</tr>
</thead>
<tbody>
<tr>
<td>🧨</td>
<td>🧨</td>
</tr>
<tr>
<td>🧨</td>
<td>🧨</td>
</tr>
</tbody>
</table>
Grow

Sets the turtle to a bigger size – makes the turtle larger. This command has no effect if the turtle has reached its maximum size.

Shrink

Sets the turtle to a smaller size – makes the turtle smaller. This command has no effect if the turtle has reached its minimum size.

Stamp

Stamps the turtle’s shape. Move the turtle a bit and you will see the stamped image. Stamped images are just like drawings on the page background. You can edit a stamped image using the tools in the Painting Center.

Clean Page

Clears all the background graphics, including stamped shapes and stamped text. This command does not affect turtles, text boxes (unless they are stamped) and buttons.

Set to Turtle Shape

Sets the turtle back to the turtle shape. This functions in the same way as the Set to turtle shape button in the Shapes Center (see above).

Stop Everything

Stops all processes on the page including animations, recordings, melodies, and button actions.
Step

Moves the turtle forward or backward by the selected step size. Click on the button and the following dialog box opens:

Technical note: One step equals one pixel on the screen.

Slide the solid-colored foot forward or backward to the desired step size or type a number in the box.

Click on the arrows on either side of the box to increase or decrease the step size by increments of one, or, type a number in the white box to set the step size.

Turtle steps on the scale, in the dialog box, are the same as turtle steps on the page. Children can look at this scale to figure out how far they want the turtle to move. The step-size can be set to a number greater than 160 by typing the number in the white box, but the distance won’t be shown on the line. The foot moves to the far left or right of the screen to indicate a number larger than 160. The maximum value is 9999.

To set a random input to step, set the step size to “one more than the maximum number you want for the size”. Then click the die to indicate that you want MicroWorlds to pick a random number from all the positive numbers, including 0, less than the number in the box. If you set the step size to 50 and click on the die, the turtle step size will be a random number between 0 and 49, inclusive.
**Turn**

Tells the turtle to turn or pivot the number of degrees selected. Click on the icon and the following dialog box opens:

When this tool is used in direct mode, the dialog box opens with the red knob heading in the same direction as the turtle is heading. This reinforces the idea that you are about to make an “immediate” turn, from the turtle’s current heading.

When this tool is used while constructing instruction lines (inside turtles, buttons or procedures), the dialog box opens with the red knob pointing up because there is no way to know where the turtle will be heading when this instruction will be executed. See *Inside Turtles, Inside Buttons* and *Making Your Own Procedures* below.

Drag the red knob to set how far the turtle will turn. The number of degrees is indicated in the center box. Drag the knob clockwise to set a right turn, drag it counter-clockwise to set a left turn, click on the arrow keys above the wheel to change the input with precision.
To select a random turn, set the turn size to one more than the maximum turn size that you want. Then click the die to indicate that you want MicroWorlds to pick a random number for the turn size from all the positive numbers less than the number in the box, including 0.

**Wait**

Causes MicroWorlds JR to pause for a specific number of ticks. Each tick is one tenth of a second. Click on the wait button and the following dialog box opens:

![Pause dialog box](image)

Drag the slider to the number of ticks desired. The bird pauses between each up and down motion a length of time equal to the selected number of ticks.

To select a random input for wait, set the number of ticks to one more than the maximum number of ticks you want. Then click the die to indicate that you want MicroWorlds JR to pick a random number from all the positive numbers less than the number of ticks, including 0.

**Pen Up**

Picks the turtle’s pen up. When the turtle moves, it does not draw a line. The turtle’s pen is up when you open a new MicroWorlds JR project.
Pen Down

Puts the turtle’s pen down. When the turtle moves, it draws a line. The turtle’s pen is up when you open a new MicroWorlds JR project. See Set color and pen size below.

Set Color and Pen Size

Sets both the turtle’s and the turtle’s pen’s color. Click on the button and the following dialog box opens:

Click on a color to select it. Use the slider to display different shades of the available colors.

Click on one of the width lines to set the pen’s width.

To randomly select a color, click on the die and click OK.

Home

Moves the turtle that’s listening (the current turtle) to home position, which is the center of the screen.
Head North

Rotates the turtle so that it is heading up, with its nose pointing to the top of
the screen. This is equivalent to setheading 0 (set heading to 0).

In regular (text-based) MicroWorlds, the input to setheading is degrees. The
degrees correspond to those of a compass: 0 degrees is due North, 90 is East, 180
is South, and 270 is West.

The Turn command turns the turtle a number of degrees to the right or left,
relative to its current heading. Setheading makes a turtle point to a specific
direction, regardless of its previous heading.

Hide

Hides the turtle if it is showing.

If you are looking for a “lost” hidden turtle, use the Key tool to make all turtles
visible temporarily. Open the turtle’s dialog box using the Key tool and when you
close the dialog box, this turtle will be the current turtle. You can now make it
visible using the Show command.

Show

Shows the turtle if it’s hidden.

Click Off the Turtle

Stops any OnClick instruction that was started by a mouse click on the current
turtle (the turtle that is listening to commands). This command has an effect only
if the turtle is running its OnClick instruction. See Inside Turtles below.
Click On the Turtle

Starts the OnClick instruction for the current turtle (turtle that is listening to commands). This command has an effect only if the turtle is not already running its OnClick instruction. To start many turtles OnClick instructions at the same time, drag around all the turtles so that they are selected, then click on the Click On the turtle button. See Inside Turtles below.

Signal

“Broadcasts” a signal color for the turtles to detect. Turtles can be programmed to react to a color signal that is broadcast. If no turtle is set to detect a signal for that color, nothing happens.

Click on the button and this dialog box opens:

Select a signal color and click OK. The signal command broadcasts that color as a message and the Signal Viewer displays that color, flashing it brightly for a second as the message is broadcast. Then, the Signal Viewer is dimmed, but still set to the same color as a reminder of which color was the last color broadcast.

This command must be used in conjunction with turtles programmed to react to a color signal. See OnSignal, in the section Inside Turtles below.
Painting Center

Clicking on the Painting Center. The section on the left contains painting tools and the section on the right contains the color palette. Scroll the palette to see the different shades of the available colors.

Pencil

Draws in the selected color and line thickness. Besides being used to draw directly on the page, the Pencil is also used to set a pen size and a pen color for the turtle: select the Pencil, a color and a line thickness, then click on a turtle on the page.

Straight Line Pencil

Draws a straight line in the selected color and line thickness.
**Rectangle**

Draws a rectangle (unfilled) in the selected color and line thickness.

**Filled Rectangle**

Draws a filled rectangle in the selected color.

**Eraser**

Erases graphics as you drag it across the background, using the selected width. Objects such as turtles, text boxes, and buttons are not part of the background graphics, so they are not erased (If the turtles or text are stamped, they are part of the background graphics and are erased.) If you double-click on the eraser, all the graphics on the page are cleared. Use the Undo tool to restore anything you may have erased accidentally.

**Color Picker**

Picks the color in the graphics background where you click. The color becomes the selected color for painting. The Color Picker works only on background images; for instance, it won’t “read” the color of turtles or the shapes they are “wearing”.

**Clean Page**

Clears all graphics, stamped shapes and stamped text on the page, unless the background has been frozen.

**Freeze Background**

Freezes the background graphics in their current state so they can’t be erased. You can still draw over the background and erase the new drawings, but the original background (before freezing) won’t be erased.
**Text Stamper**

Changes the cursor to a text stamper that is used to stamp an image of the text in a text box onto the page background. Click on the Text Stamper button and then on any text box to stamp an image of its text. The text is stamped “on the spot” and the text box is moved a little bit lower, to the right.

![Text Stamper Image]

If you click on the text using the Key tool, you see that the lower text is actually a text box. You can delete the text box or move it elsewhere on the page to stamp it again, with the same text or different text.

![Text Box Image]

The stamped text (the text that isn’t inside the box in the picture above) is now part of the page background. It cannot be edited but it can be erased or moved using the painting tools or the Clean Page command. See the Painting Center and the Turtle Commands Center.

**Fill**

Fills an enclosed area with the selected color. Use the Undo tool to restore an area that you have accidentally filled.

**Spray Can**

Sprays speckles of the selected color in the selected width.

**Oval**

Draws an oval (unfilled) in the selected color and line thickness.
Filled Oval

Draws a filled oval in the selected color.

Selector

Selects a rectangular area of graphics. Once a selection is made on the page’s background, you can:

- Drag the rectangle to relocate the selected graphics elsewhere on the page;
- Use the Copy selected area tool, menu item or key combination (Ctrl-C) to “take a picture” of the selected graphics in order to paste them onto a different page, inside a Graphics Editor, or in a different application;
- Use the Cut selection tool, menu or key combination (Ctrl-X) to delete the selected graphics, while maintaining a copy in the clipboard in order to paste them later.
- Right-click in the selected area to open the Graphics Editor, which displays an enlarged view of the selected graphics.

Copy Selected Area

Copies (takes a picture) of the selected area in order to paste it elsewhere on the page, on a different page, or inside an image editor. An area must first be selected with the Selector.

Paste

Pastes on the page or inside the image editor whatever graphics area was previously selected and copied or cut.

Edit Selected Area

Used to do detailed editing of a graphic. Select a region of the background with the Selector, then click on the Edit Selected Area tool. When the editor opens, the selected background graphic is magnified to the maximum size in which it can be completely displayed.
Cut Selection

Cuts whatever background graphics have been selected with the Selector.

Page Center

Clicking on the in the Center Openers toolbar opens the Page Center. The New Page button creates new pages and the empty spaces are containers for the pages that you create.

In the Page Center below, there are three pages in the project. Click on the New Page button to create a new page. Click on a page button to display that page. Right-click on a page label to edit it.

Note: A project opens on the page that was showing when the project was saved.

Duplicating a page

In a multi-page project, you may want a second page to be just a slight modification of the first one you did (the same background and turtles, for example). Simply duplicate the first page and make the necessary changes on the second page.

1) Click on the Copy tool .

2) Click on the page that you wish to duplicate. The hand closes, indicating that it has “grabbed” the page.

3) Click on an empty square. You now have two identical pages. Click on the page to open it.
Removing a page

Click on the Cut (scissors) tool in the General Tools section of the left toolbar and click on the button of the page that you want to remove. You cannot remove the last and only page of your project.

Caution: Deleting a page cannot be undone. Once you remove a page, you can only recover it if the project was previously saved. If you’ve accidentally deleted a page from a saved project, choose Open Project from the File menu or the top toolbar. Click No when the Save Changes Before Closing box comes up. Then reopen the saved version of the project.

Editing a page label

Right-click on a page button or click on the page button with the Key tool to edit its label. The Label Editor allows you to change the aspect of the label representing a page, a sound, a melody or a procedure. Refer to the section Shapes Commands for a description of the Editor.

Using page buttons as commands

Clicking on page buttons in the Page Center displays the desired page. It is equivalent to a get-page command. In addition to this direct method of displaying pages, page commands can be used inside turtles, buttons and procedures to go from page to page, based on user interactions or programmed actions on the page. See Inside Turtles, Inside Buttons, and Making Your Own Procedures further in the Guide.
Recording Center

Clicking on in the Center Openers section of the left toolbar opens the Recording Center. Using the Record a new sound button or the Load a sound button, you can record your own sounds (provided that you have a microphone attached to your computer) or load one of the pre-recorded sounds into your project. The empty spaces are containers for the sounds that you create or load into your project. In the Recording Center below, there are two sounds in the project.

Recording a new sound

To record a new sound, click on the Record a new sound button on the left end side of the Recording Center to open the Recording dialog box:
The Record, Stop and Play buttons do what their names imply. If you use the Record button more than once while the dialog box is open, the new recording always overwrites the previous one.

After recording a sound, either click on: the Label Editor to edit the label for that sound and save it; OK to save the sound (without changing the label); or Cancel to not save the sound. Note that you can edit the label at a later time by right-clicking on the button in the Recording Center or clicking on the button using the Key tool.

Loading a pre-recorded sound

To load a pre-recorded sound into your project, click on the Load a new sound icon on the left-hand side of the Sounds Center. This opens a special window that lists available sounds:

Select a sound from the list and click on Play to hear it. After selecting a sound, either click on: the Label Editor to edit the label for that sound and save it; OK to save the sound (without changing the label); or, Cancel to not save the sound file in your Recording Center.
Editing a sound label

The Label Editor lets you change the aspect of the label representing a page, a sound, a melody or a procedure. You can open the Label Editor directly from within the Record a new sound or Load a sound dialog box. Alternately, you can right-click on the sound button directly in the Recording Center. Refer to the section Shapes Commands for a description of the Editor.

Removing a sound

Click on the Cut (scissors) tool in the General Tools section of the left toolbar and click on the button of the sound that you want to remove. Use the Undo tool immediately if you change your mind about this action.

Using sounds as commands

Clicking on a sound button in the Recording Center plays the chosen sound. It is the same as a Play this sound command. In addition to this direct method of playing sounds, sound icons can be used inside turtle, button and procedures, to play sounds based on user interactions or programmed actions on the page. See Inside Turtles, Inside Buttons, and Making Your Own Procedures further in the Guide.

Melody Center

Clicking on in the Center Openers toolbar opens the Melody Center. Using the Record a melody button or Choose a melody button on the left, you can create your own melodies on a piano keyboard or load one of the pre-recorded melodies into your project. The empty spaces are containers for the melodies that you create or load into your project. In the Melody Center below, there is one melody created with the Melody Editor and one imported pre-recorded music file.
Recording a new melody

To record a new melody, click on the Record a new melody button in the Melody Center to open the Melody Editor:

Click on the piano keyboard to create a melody. The “score” of the melody appears at the top. You can select notes in the score and delete them, copy them, cut them, or change their duration. You can click anywhere in the list of notes and add new notes by clicking on the piano keyboard.

If you want to play only a section of your score, select those notes in the score, then click on the Play button.
To change the duration of a group of notes in the score, first select them, then choose one of the duration notes. All of the notes in the selected group change to that duration.

You can also change the tempo and the volume of the melody using these icons: 

A melody can use only one instrument at a time, but different melodies can use different instruments.

After recording a melody, either click on:

- The Label Editor to edit the label for that melody and save it,
- OK to save the melody (without changing the label),
- Or, Cancel to not save the melody.

Note that you can edit the label later on, by right-clicking on the melody button in the Melody Center.

### Loading a pre-recorded melody

To load a pre-recorded melody into your project, click on the Choose a melody button in the Melody Center. This opens a special window that lists available melodies:
Select a melody from the list and click on Play to hear it. After selecting a melody, either click on:

- The Label Editor to edit the icon for that sound and save it,
- OK to save the sound (without changing the label),
- Or, Cancel to not save the music file in your Melody Center.

**Editing a melody label**

The Label Editor allows you to change the label representing a page, a sound, a melody or a procedure. You can open the Label Editor directly from within the Record a new melody or Choose a melody dialog box. Alternately, you can right-click on the melody button in the Melody Center or click on the melody button with the Key tool. Refer to the section Shapes Commands for a description of the Editor.

**Removing a melody**

Click on the Cut (scissors) tool in the General Tools section of the left toolbar and click on the button of the melody that you want to remove. Use the Undo tool immediately if you change your mind about this action.

**Using melodies as commands**

Clicking on a melody button in the Melody Center simply plays the chosen melody. It is equivalent to a Play this melody command. In addition to this direct method of playing melodies, melody commands can be used inside turtles, button and procedures, to play melodies based on user interactions or programmed actions on the page. See Inside Turtles, Inside Buttons, and Making Your Own Procedures further in this Guide.
Instruction Lines

The preceding section described how to use commands in direct mode by opening the appropriate Center and clicking on the desired command to produce an immediate result.

Instructions lines consist of the same commands placed inside turtles, buttons and procedures. There are several good reasons to do this:

- You don’t have to remember the sequence of commands as they are stored inside the turtle, button or procedure;
- You can run several commands in a predictable order with one mouse click;
- You can make one event (for example, a turtle crossing over a color) trigger another (the turtle grows) so that it seems like actions are happening “by magic”
- You don’t have to grab the commands from the different Centers.

The next three sections, Inside Turtles, Inside Buttons and Making Your Own Procedures, deal with various techniques how to use when grouping several commands of any type.

Creating and editing instruction lines

An instruction line can have commands from the Turtle Commands Center, the Recording Center, the Melody Center or the Page Center. Turtle commands are used to “give life” to turtles, recordings and melody commands add audio to your project and page commands are used to go from one page to another.
Here is an example of an OnClick instruction line:

![Diagram of instruction line with commands]

If you click on this turtle, it grows, waits a bit, shrinks, plays Melody 1 and goes to Page 2. The arrow beneath the commands indicates that these instructions are carried out only once.

To add instructions to the instruction line, click on commands in the Turtle Commands Center, the Page Center, the Sounds Center or the Melody Center. You cannot add tools found in the Painting Center to the instruction line – use turtle commands to draw instead.

The flashing vertical bar in the instruction line is the insertion point. This is where new commands are inserted. You can position the insertion point anywhere on the line to insert new commands or to delete the command that is on the left using the Backspace key or to the right using the Delete key on the keyboard. You can also use the Cut (the “scissors”) tool to delete commands.

You can also change the input used for commands already in an instruction line. In the example above, there is a “two-tick” wait between the Grow and the Shrink commands. Pick the Key tool in the General Tools section of the left toolbar and click on the Wait command in the instruction line. Its dialog box reopens and you can set a different value for the number of ticks.
**Lost commands in instruction lines**

A white square, like in the following example, indicates that the command that had been there cannot be executed anymore because it has been deleted.

If you compare the last two pictures, you notice that the fourth icon was, in fact, a melody. It is sometimes hard to find exactly what was deleted and in this case, you can either:

- Recreate the missing elements exactly in the same spot (in this example, recreate a melody in the now empty space in the Melody Center where it was originally), or
- Delete the command from the instruction line (see *Creating and Editing Instruction Lines* above), recreate the command (the melody, in this case) and reinsert it in the instruction line (see technique above).
Inside Turtles

The turtle is the central character in MicroWorlds JR. It responds to the turtle commands and can be used to draw, to create animation and to act like a button and start other events.

Each turtle has a backpack in which it keeps its instructions. Right-click on a turtle and its backpack opens. You can also pick the Key tool in the General Tools section of the left toolbar and click on the turtle.

There are four tabs in the backpack for four different types of action or event instructions:

To add instructions to the instruction line, first select the appropriate tab (OnClick, OnColor, OnTouch, OnSignal) and click on commands in the Page Center, the Sounds Center, the Melody Center, or the Turtle Commands Center, including procedures that you may have created.

Clicking OK saves all the contents of the backpack (all tabs). Clicking Cancel cancels any changes made to the backpack since the last OK.
**OnClick**

The instructions in this tab run whenever you click on the turtle. If the tab is set to run forever, the instructions stop running when you click on the turtle again, or when you click on one of the *Stop everything* buttons in either the top toolbar or in the Turtle Commands Center.

Remember that you don’t have to click on a turtle with the mouse to activate its OnClick instruction. There are two commands in the Turtle Commands Center that simulate clicking on and clicking off the turtle. Using these, you can “click” on a turtle without actually clicking on a turtle. Take this turtle and this button, for example:

![Turtle and Button](image)

If you click on the turtle, it spins in one spot forever (notice the *Forever* setting). If you click on the button instead, the button “clicks on” the turtle, plays a melody, and “clicks off” the turtle. In other words, the turtle spins in one spot for the exact duration of the melody. This is a nice trick to synchronize a turtle action and a song.
**OnColor**

The instructions in this tab run whenever the turtle crosses the selected color on the page background. It does not react to other objects on the page that may be in color, such as text, buttons and other turtles. If you stamp turtles and text, then the stamped images become part of the background and can be detected by OnColor.

To program an OnColor action, open the turtle’s backpack, click on the OnColor tab, click on one of the houses to select the color to be detected (a white frame appears) and add commands to the instruction line. The turtle can run different sets of instructions for each different color; simply select a different color and create an instruction line for that color. When a color has a list of instructions associated with it, a frame appears around it. In the following picture, the displayed instruction line *(Step 20 Turn 90)* is run when the turtle crosses the blue color in the bottom row. There’s also an instruction for orange (in the top row), but the instruction line is not currently showing.

![OnColor Tab Example](image-url)
**OnTouch**

The instructions in this tab run whenever the turtle touches another specified turtle. This tab is not available if there is only one turtle on the page. When the tab opens, the other turtles on the page are displayed below the instruction line area. The instruction line that is showing runs when the current turtle (who owns the backpack) touches the turtle in the highlighted white box. The current turtle can run a different set of instructions for each turtle on the page. When a turtle (one to be touched) has a list of instructions associated with it, a frame appears around it.

For example, in the following picture, there are three other turtles on the screen, one shaped like flowers, one like a tree and one like a bird. The instruction in the instruction line that is displayed (*Turn 180 degrees*) runs when the turtle (the one that owns the backpack) touches the bird. There is also an instruction that is run when the turtle touches the flowers, but this instruction is not currently displayed. You would have to click on the flowers to see it.
Programming OnTouch instructions only makes sense for moving turtles. The turtle programmed with an OnTouch instruction should probably be programmed to move by itself using Step instructions either in an OnClick instruction set to *Forever* mode, or in a procedure with a repeated instruction. In the example below, this turtle has an OnClick instruction to do *Step 1 in Forever* mode, and it has an OnTouch instructions (for the flowers) to do *Turn 180* (degrees).

Note that you won’t be able to distinguish different “target” turtles if they all have their original turtle shape. Before trying to program OnTouch instructions, give your turtles different shapes.

**OnSignal**

The Signal command in the Turtle Commands Center “broadcasts” a color signal. If a turtle is programmed to detect a signal of a particular color, it reacts when that color is broadcast. Several turtles can be programmed to react to a given signal or one turtle can be programmed to react to different color signals.

For example, you can program a turtle shaped like a sun to rise, a turtle shaped like a flower to grow and a turtle shaped like a bird to fly when the signal “red” is detected. All three actions will take place when you use the *Signal* command in the Turtle Commands Center to broadcast the signal “red”.

When a signal is broadcast, the *Signal Viewer* at the right of the top toolbar first displays the color, flashing it brightly for a second. At all other times, the *Signal Viewer* is dimmed but stays set to the color of the last signal that was broadcast as a reminder.
To see how a signal works, right-click on a turtle and set its OnSignal Purple instruction to *Hide*. Then click on the green circle and set the turtle’s OnSignal Green instruction to *Show*.

In the pictures above, the color circle *framed in white* is the color that you are currently programming. The circle framed in light green indicates that there is also an instruction line for that other color, but it is not the instruction line currently displayed.

Click *OK* to close the backpack. Open the Turtle Commands Center and use the *Signal* command to broadcast different colors: first purple, then green. The turtle should hide and then reappear when you broadcast the green signal.
Inside Buttons

Buttons run instructions when you click on them. While the instructions are running, you can do other things. For example, you can type in a text box or click on other buttons or “clickable” turtles.

A button can be set to run its instruction once or repeatedly.

Click on the New Button tool in the Object Creation section of the left toolbar and click on the page. The button dialog box opens. To add an instruction, open one of the work centers and click on a turtle command, a page command, a music command or sound command or a procedure. For example, the following button is used to switch pages. It is set to run its instruction Once.

![Button dialog box](image)

When you click OK, a button that shows the instruction icons appears on the page:
Click on the button to run its instructions. If the instruction takes a long time to execute, or if the button is set in \textit{Forever} mode, click on it again to stop it. If the button brought you to a different page (and you can’t see it to click it off), you can stop its action using the \textit{Stop everything} button in the top toolbar.

\textbf{Resizing buttons}

If the button is too small to show all its commands, like in this example:

1) Select the button (drag around it) to make its “handles” appear:

2) Then, drag one of its handles:

Note that the button works even if all of its commands are not showing.

To edit the contents of a button, right-click on it or click on it using the \textit{Key} tool. \textit{See Instruction Lines} above for more information about creating and editing instruction lines.
Making Your Own Procedures

MicroWorlds JR comes with a set of built-in single action commands; for example, Step, Turn, Pen up, Stamp, etc. You can also create your own procedures, which work like built-in commands but they do several actions, depending on how many commands you include in them.

A procedure is a command created by a user. It works only in the project in which it is created. A procedure is an organized list of commands designed to provide an easy, one-button (or one-word) command for a sequence of commands that will be used frequently. Since a procedure acts like a built-in command, it can also be included in other procedures. A procedure that is included in another procedure is referred to as a subprocedure. A superprocedure is the procedure that uses (or “calls”) a subprocedure.

For example, instead of clicking on eight commands to create a square, you may want to create a Square procedure that draws a square with just one user-created command.

Right-click on an empty command space in the Turtle Commands Center (an empty space on the right, not an empty Shape space!)
The following dialog box appears.

Click on the series of commands that you want to use in your procedure, in the order in which they should be executed. For example:

After creating your instruction line, click on either:

- The Label Editor to edit the label for that procedure and save it;
- OK to save the procedure (without changing the label); or,
- Cancel to not save the procedure.

Note that you can edit the label later by right-clicking on the icon in the Turtle Commands Center or by clicking on the icon with the Key tool.
Your Turtle Commands Center now may look like this (the new procedure is indicated). In this example, the default label has not been modified:

Click on the procedure to try it!

Editing a procedure

To edit the contents of a procedure, right-click on its icon or click on it using the Key tool:

See Instruction Lines above for more information about creating and editing instruction lines.

Repeating the instruction line

You may want a series of commands repeated more than once. If that’s the case, change the number in the box next to the word Repeat:

Step by Step

The Step by step button in the procedure dialog box lets you step through the instruction line one instruction at a time to help debug a procedure. Place the insertion point (the vertical bar) at the beginning of (or anywhere in) the instruction list and click the Step by step button.

Before doing so, make sure that the turtle who is executing the commands is not hidden by the dialog box. If it is, move the dialog box aside by dragging it by its title bar.
Removing a Procedure

Click on the Cut (the “scissors”) tool in the General Tools section of the left toolbar and click on the button of the procedure that you want to remove. Use the Undo tool immediately if you change your mind about this action.

Duplicating a Procedure

You may want a second procedure to be just a slight modification of the first one you did (for example, you may want a big square and a little square). Simply duplicate the first procedure and make the necessary changes in the second procedure.

1) Click on the Copy tool.

2) Click on the procedure that you wish to duplicate. The hand closes, indicating that it has “grabbed” the procedure.

3) Click on an empty command space. You now have two identical procedures.
   Right-click on the new procedure to edit it.

Linking a procedure to a specific turtle

If a procedure is not “linked” to a turtle in particular, the current turtle executes the commands. The current turtle is the last turtle that you have created, or the last turtle on which you have clicked.

If there are several turtles on the screen, there are two ways you can specify which turtle will run the procedure.

After the procedure is defined, click on one of the turtles on the screen (it becomes the current turtle) and then click on the procedure icon. The turtle on which you clicked runs the procedure. Another time, you may decide that you want another turtle to run the procedure. All you need to do is click on the other turtle (it becomes the current turtle), click on the procedure button, and the second turtle runs the procedure.
You can link a procedure to a specific turtle. In this case, that turtle, and only that turtle, will always be the one to execute the turtle commands contained in that procedure. In order to do this, you must have more than one turtle on the page when you specify which turtle will execute the procedure:

To link a turtle to a procedure:

1) Click on the Show me the turtles button in the procedure’s dialog box.

2) A “list” of all available turtles appears. It may look like this (Note: If several of your turtles have the same shape, you won’t be able to tell which is which. It’s a good idea to set your turtles to different shapes or colors):

3) Click on the turtle that will always run this procedure. A white frame appears around it.

4) Click OK and try your procedure. Create a new turtle and try the procedure again. Only the turtle you selected in the procedure’s dialog box should run the procedure.

Important: If you link a procedure to a turtle and you later delete this turtle, your procedure loses its link. It becomes a “general” procedure and its turtle commands will be executed by whatever turtle is the current turtle.

Looking at your procedure as text

To see the list of commands that are used in the procedure, click the Show written commands button:

You will see a list of all the commands, in the order in which they appear in the procedure. You can then flip back to the iconic view.

You can also use the written commands side to write procedures using MicroWorlds commands. If you write a procedure with text commands, you cannot flip to the iconic view. In fact, if you make any changes, even slight ones, in the text, you cannot flip back to the iconic view.
Menus

File Menu

<table>
<thead>
<tr>
<th>File</th>
<th>Edit</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Project</td>
<td>Ctrl+N</td>
<td>Ctrl+N</td>
</tr>
<tr>
<td>Open Project...</td>
<td>Ctrl+O</td>
<td></td>
</tr>
<tr>
<td>Import</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Save Project</td>
<td>Ctrl+S</td>
<td>Ctrl+S</td>
</tr>
<tr>
<td>Save Project As...</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Page Setup...</td>
<td>Ctrl+P</td>
<td>Ctrl+P</td>
</tr>
<tr>
<td>Print Page...</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Print Project</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Exit</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

New Project

Opens a new project. If there is an open project already on the screen, you’ll be asked if you want to save it first.

Open Project

Opens a dialog box where you choose which project to open. If there is already an open project on the screen, you’ll be asked if you want to save it first.

Import

Music

Opens a dialog box where you can choose a music file (extensions MID, MIDI, RMI, MP3, and M3U) and places the appropriate icon in the Music Center.

Picture

Opens a dialog box where you can choose a picture file and places it on the page as part of the background graphics.
Sound
Opens a dialog box where you can choose a sound file (extensions WAV, AU, AIF, AIFC, AIFF, and SND) and places the appropriate icon in the Recording Center.

Text
Opens a dialog box where you can choose a text file. The contents of the text file are copied into the current text box.

Save Project
Saves any changes you’ve made to the project.

Save Project As
Opens a dialog box where you choose a new location and/or name for your project.

Page Setup
Opens a dialog box where you can choose the paper size and other printer details before you print.

Print Page
Opens a dialog box to print the contents of the project page. The page will be printed just as it appears on the screen. If a text box contains more text than is visible, only the text you see on the screen will be printed. Choose Page Setup before printing.

Print Project
Opens a dialog box to print all the pages in your project. Choose Page Setup before printing.

Exit
Exits MicroWorlds JR. If you have made changes to the current project, you’ll first be asked if you want to save it.
Edit Menu

<table>
<thead>
<tr>
<th>Edit</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Undo</td>
<td>Ctrl+Z</td>
</tr>
<tr>
<td>Cut</td>
<td>Ctrl+X</td>
</tr>
<tr>
<td>Copy</td>
<td>Ctrl+C</td>
</tr>
<tr>
<td>Paste</td>
<td>Ctrl+V</td>
</tr>
<tr>
<td>Select All</td>
<td>Ctrl+A</td>
</tr>
<tr>
<td>Clear</td>
<td>DEL</td>
</tr>
<tr>
<td>Stop All</td>
<td>Ctrl+Break</td>
</tr>
</tbody>
</table>

**Undo**

Undoes the last text editing operation, painting action, or deletion of page elements (buttons, for example). Programmed actions cannot be undone.

**Cut**

Cuts the selected text, graphics, or MicroWorlds JR objects on the page and puts it in the Clipboard, ready to be pasted elsewhere.

**Copy**

Copies the selected text, graphics, or MicroWorlds JR objects and puts it in the Clipboard.

**Paste**

Pastes the contents of the Clipboard. Paste only works if the contents of the Clipboard are of the right type for the current location (for example, you can’t paste graphics in a text box).

**Select All**

Selects all the objects on the page, including those that are not visible. If the cursor is inside a text box, all the text is selected.
Clear

Clears whatever is selected. If the cursor is in a text box, the selected text is erased. If objects (buttons, sliders, turtles, etc.) are selected, they are removed.

Stop Everything

Stops all running processes, including repeating processes launched by buttons and clicked turtles, music and sounds.

Pages Menu

<table>
<thead>
<tr>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>page1</td>
</tr>
<tr>
<td>page2</td>
</tr>
<tr>
<td>page3</td>
</tr>
</tbody>
</table>

Page1

All pages in the current project are listed in the Pages menu. Selecting a page displays it. A project opens on the page that was showing when the project was saved. Clicking a page name in the menu is the same as selecting a page icon in the Page Center.
Section IV - Handy Techniques

The In Front/In Back Technique

Sometimes when students are using multiple animated turtles in a scene, they want one turtle to be in back of or in front of another. The last turtle created is always in front of the other turtles. Here is a technique to change the order of the turtles. If the wrong turtle is in front:

1) Hold the mouse button and drag the mouse over the turtle that you want “in front” so that it is selected.
2) Select Cut in the Edit menu.
3) Select Paste in the Edit menu.

The pasted turtle is now in front of the other turtles.

Switching Pages Using Some Magic

The first and obvious method for going from page to page consists of using the buttons in the Page Center or the page list in the Pages menu. Another choice is to include page switchers directly on your pages. This adds a nice touch to multi-page projects and solves any page-switching problem that may arise when in Presentation Mode.

Here are a few techniques that let you switch pages without using the Page Center or the Pages menu.

Using a button

This button, placed on Page 1, makes a slide show that comes back to Page 1 at the end. You can include a Wait command anywhere in the instruction list.
Using a clickable turtle

If you need something nicer than a button, you can create a clickable turtle wearing a pretty shape. Clicking on this turtle, located on Page 1, goes to Page 2, simulates a click on the turtle on Page 2 (for example, it animates when clicked), goes to other pages, waits a bit and comes back to Page 1.

Using color detection

In this example, the page switch occurs when the animated turtle on Page 1 runs over the light blue color. Its OnClick instruction says “Step 1 Wait 1” in Forever mode. Its OnColor instruction says “Click me off and Go to Page 2”. You want to click this turtle off before leaving Page1, because, otherwise, it keeps running and crosses over the light blue color again and again … you will forever be brought to Page 2 if you don’t click it off!
Using Your Own Shapes in a Project

Sometimes you may want students to create a project using only shapes you’ve pre-selected for them or no shapes at all. In order to do this, you should open a new project and create the shapes you want to use. You can either use the shape editor to create shapes or you can import pictures into MicroWorlds JR. For example, you may want to create a project using photos of the faces of all the children in class as shapes.

In order to do this, you must paste the pictures into an empty shape space.

Delete any shapes you do not want to use.

To create new shapes from imported pictures:
1) Select **Import picture** in the **File** menu
2) Select all or a part of the picture using the Selector in the Painting Center
3) Click on Copy in the **Edit** menu
4) Open the turtle Commands Center and right-click on an empty shape space
5) Click on Paste in the **Edit** menu to paste the image into the space. Click OK.

   The shape automatically adjusts to 40 x 40, the shape size.

Save the project with your new shapes. Give it a name that clearly indicates to students that it’s the project they should use. For example: **Project Starter**.

Students should use this project when building their projects. As soon as they open the project they should save it under a new name. In this way, students will not overwrite the original project and there is no confusion at the end of the class as students hurry to finish and save.
Section V - MicroWorlds JR
Commands vs. Traditional MicroWorlds Text Commands

All of MicroWorlds JR concepts and commands have a traditional MicroWorlds counterpart. One way to “visualize” the correspondence is to include the commands in procedures and use the Show written commands button in the Procedure dialog box.

Following is a list of turtle commands as they appear in MicroWorlds JR and their text equivalent in the traditional MicroWorlds language.

- setsize size + 5
- setsize size – 5
- stamp
- clean
- setshape (setsh) 0
- stopall
- forward (fd) number (or random number)
- back (bk) number (or random number)
- right (rt) number (or random number)
- left (lt) number (or random number)
<table>
<thead>
<tr>
<th>Wait number</th>
</tr>
</thead>
<tbody>
<tr>
<td>pd (pen down)</td>
</tr>
<tr>
<td>pu (pen up)</td>
</tr>
<tr>
<td>Setcolor (setc) number (or random number)</td>
</tr>
<tr>
<td>Home</td>
</tr>
<tr>
<td>Setheading (seth) 0</td>
</tr>
<tr>
<td>St (show turtle)</td>
</tr>
<tr>
<td>Ht (hide turtle)</td>
</tr>
<tr>
<td>Clickoff</td>
</tr>
<tr>
<td>Clickon</td>
</tr>
<tr>
<td>Broadcast</td>
</tr>
<tr>
<td>Setshape (setsh) number or name</td>
</tr>
<tr>
<td>Newpage</td>
</tr>
<tr>
<td>Page1 or any pagename (the name of a page, in traditional MicroWorlds, is a command that opens the page)</td>
</tr>
<tr>
<td>Melody1 or any melody name (the name of a melody, in traditional MicroWorlds, is a command that plays that melody)</td>
</tr>
<tr>
<td>Sound1 or any soundname (the name of a sound, in traditional MicroWorlds, is a command that plays that sound)</td>
</tr>
</tbody>
</table>